
GEY 430/630 – GIS – Theory and Application 

 
 1

Lab 2. Practice with ArcGIS 
 
Purpose: To practice map composition and printing in ArcGIS 
 
To Do and Hand In:  Compose, print, and hand in two maps, described below.  Maps due in lab 

one week after assignment. 
 
Clean-up:  To preserve disk space it is necessary for you to back-off the previous labs datasets.  
Please do this before copying the new lab’s datasets to your area. 
 
Data Source: S:\GEY430_630_Spr04\arc_practice 
 
 
 

This is the first assignment 
you will be creating.   
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Start ArcGIS  (from the Program Menu; see Lab 1 if you forgot) 
 

 
 
 
 
 
 
 

 
 

When ArcGIS starts 
select the “A new 
empty Map” and click 
 OK 

Does your screen look like 
this? 
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Now before each exercise you should set up your 
file name, you map name (for later documentation 
purposes) and other details of how the map will be 
saved. 
 
Select File (from the Main Menu) 

Select the  
“Save As” and navigate to your 
area and the appropriate 
subdirectory; for this exercise 
use DATADRIVE:\av_practice 

Now your new file name should 
appear at the upper left. 
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From FILE (on the Main Menu) select 
MAP PROPERTIES. 
 
 
This is where you add your title and 
other information (for documentation) 
for now just add a name, like  
Lab 2 – Project 1 

Then select the  
Data Source Option button. 
 
Select the  
STORE RELATIVE PATH NAMES 

HINT 
As you move to different computers or send maps to other users you will find that other letters are used for the disk 
drives, like D:\ or L:\ or Z:\.  This “relative path names” option stores the relative location of the data layers, which 
makes the map more easily transportable.
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Now lets get ready to add data to our map. 

Select the  button. 
 
The first time you do this the program ask you to 
set up your “connection”.  This is a time saver by 
allowing you to set a “default” directory.  

Navigate to your data subdirectory, for 
our lab it is 
 
 S:\GEY430_630_Spr04\arc_practice 
 
Click the OK and then ADD 
 
Your path is saved.  Now every time 
you ask to add data it “remembers you 
path” 

Now add your data. 
 

Click on the  button and the program 
“remembers” you place. 
 
Select four files as shown;   
Henderson_drg.Tif 
Roads shp
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Select one file then push and hold 
the Ctrl key and select the rest.  The 
Ctrl key lets you select things in any 
order.   
 
You can add files one at a time if 
you wish. 
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Your screen should appear as below 
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You rearranged layers should look like below.  Notice the Roads, Faults and Lake Mead have 
disappeared, covered by the “Topo” layer. 

 
 

Now reposition the order of the layers. 
 
 
Click on Henderson_drg.TIF  (the “Topo 
map”) 
 
Hold the right mouse button down and 
drag this layer up to the top or the stack of 
layers. 
 

As you click and hold, dragging the 
Henderson_drg.Tif layer, you will see a 
black line.  This line indicates where you 
are and allows you to drop the layer 
where you want. 
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Now Change the look of the Roads, Faults and Lake Mead 
 

 
 
 
 

Now put the layers back 
to the original order. 

Double click on 
the colored road 
line in the “Table 
of Contents”; that 
is proper name of 
the far left box of 
layers. 

Your clicks bring 
up the Symbol 
Selector.  Select 
an appropriate 
“look” for the 
roads.   
 
“Main Road” will 
do 
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Selecting “Main Road” 
Changes the color and size for 
you. 

Now change the Faults layer, 
Remember, double click on the 
Faults line and select a symbol. 



GEY 430/630 – GIS – Theory and Application 

 
 11

 
 
 
 
 
You layer should now appear as below: 
 

 
 
 

Select the Lake Mead shape.  
Select the color you want for 
the Lake, notice that you can 
choose any color you want. 
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Select the 1st layer Roads. 
 
Right Click on the title. 
 
This will bring up the Properties 
Dialog box.  We will now change 
the title of the layer. 

Change the Layer Name on the 
General Tab to 
 
“Henderson Roads” 
 
Layer Properties are used VERY 
often so remember how to get 
here.  You Right click on the 
layer property 
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Change the Layer name of the 
henderson_drg.Tif to  
 
Henderson, Nev 7.5 minute 
Topographical Quadrangle 

The Henderson layer has a long name so expand 
the Table of Contents to show the whole name. 
 
Do this by dragging the right margin bar to the 
left

Drag it this way 

Find the Zoom Buttons.  Right clicking on these changes the cursor to let 
you create boxes that magnify or minimize the map.  The arrow buttons 
zoom the whole map in or out.  Try them.  
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Zoomed in 

Find these buttons
Every time you 
zoom you are 
changing your 
EXTENT or the 
boarders of you 
Map.  These 
buttons move you 
to your previous 
extent or the 
entire extent of 
the Map.  Test 
them out  

Find the Hand Button.  This 
changes the cursor shape and 
by holding it on the Map you 
can Pan (or move) around the 
Map. 
Try and move about the Map. 
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Use the tools  or   buttons to make you Map appear as below. 
 

Find the Measure Distance 
Button. 
Use it to measure the distance 
between the Gravel Pit and the 
Lookout Tower.  The distance is 
reported in the lower left.  You 
can change the units displayed in 
the Layer Properties Menu (right 
click on it) 

Distance 
Measure
ment 



GEY 430/630 – GIS – Theory and Application 

 
 16

 
 
Now you are ready to print.  Find the Layout View button. 

 
Click the Layout View, switching away from the Data View. 
 
 
 
 
 
This is your initial Layout (printing) View. 

These buttons, the Data View 
(what you have been working 
with) and the Layout View 
switch from “getting ready to 
print” to “working with the 
data”.   
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Find the Insert Menu at the Top Menu 
 

 
 

Lets add a title. 
Select Title 
from the menu. 
  
A Blank is 
added to the 
Lay out.Type in 
the Title  
“Henderson, 
Nev Quad” 
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As Shown 

Click on the Title (in the blue 
box) and hold your mouse button 
down  
Dragging the title to the top, 
outside the colored map. 

Now click on the map.  The 
blue “handles” will appear at 
the corners.  These are you 
change points.  Click on the 
lower right and drag the picture 
up and to the left.  Making it 
smaller.  This will add room for 
other map elements. 
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Your Map should be 
similar to this picture. 

One at time you will add a: 
 
North Arrow 
Scale Bar 
Legend 
and Text (your name and date) 
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Select Insert 
North Arrow and 
select a type 
from the North 
Arrow Selector 
and click OK 

The North Arrow is always 
placed in the center of the 
Map.  Grab the click in the 
center and hold, dragging it 
to a new location.  Then 
use the handles to make the 
Arrow larger. 

Here is an example 
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From the insert Menu add a 
scale bar.  From the Selector 
screen pick a scale bar and click 

Just like the North Arrow, 
the scale bar is place in the 
center of the Map.  Click 
and drag it to a better 
location, bottom left 

Add your legend 
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There are many details for a 
Legends so there will be a 
series of screens in the 
Legend Wizard. 
 
The Wizard screen is 
important This is where you 
decide what is in the Legend. 
You use the arrow keys to 
add or delete Legend items.   
 
Move the Henderson 7.5 
minute Topographical Map to 
the Left 
The Topo does not need to be 
in the legend. 
 
Answer Next to the 
remaining screens.  After the 
Finish screen.  Move the 
legend as you did with the 
North Arrow and the Scale 
Bar. 

You are almost done.  Add Text (your 
name and date) from the Insert Menu. 
Move the Text to the lower left and 
your done. 

From the File Menu select Print. 
 
This is your first Turn In 
(A larger image is at the beginning of the 
lesson) 
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Part 2 
For Part 2, refer to the Lab 1 and the earlier part of Lab 2 for specific instructions: 
 

• Create a new Map within your current \arc_practice subdirectory.  Name it “Henderson 
Detail”. Remember to do the “Save As” step right away. 

• From the directory \arc_practice add:  Faults, Roads, Lake Mead, 
Henderson_Quadrangle, and Hen_DOQ_nw.Tif themes to the Map. (use files with the 
last name .shp or .Tif)  

• Change the Legends to correctly display the faults, lake mead and roads.  Remember road 
are black.  Change the name of the Henderson_Quadrangle layer to Henderson 7.5 
minute USGS Topographical Map.   Similarily change Hen_DOQ_nw.Tif to Henderson 
Digital Ortho Quad Photo. 

• Zoom to the Roads layer.  (by right clicking the Roads layer, then select “Zoom to 
Layer”) 

• Change the order of the layers to the following order: 
1. Roads 
2. Faults 
3. Lake Mead 
4. Topo Map   (Henderson 7.5 minute USGS Topographical Map) 
5. Photograph  (Henderson Digital Ortho Quad Photo). 
 

Uncheck the Lake Mead, making them not visible. 
 
Your View should appear as below: 
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Use the  (Magnifying Glass) to Zoom to the upper center (N) portion of the Henderson Quad. 
 
Change the cursor to the  (Pan Cursor) and move the screen around and look at the details of 
the map, center on the elevation marker of 1437 where the photo and quad come together. 
 
The Data View of you Map should appear as below: 
 



GEY 430/630 – GIS – Theory and Application 

 
 25

 
 
Change the scale to 1:2500  (in the Scale box in the upper right; type in 2500) 
Your Map Data View should appear as below: 

 
The notice the items on the Henderson USGS 7.5 minute Topographical Map (often just called 
“Topo”).  We will discuss how they are created and how to use them later in the class.  At this 
point just get acquainted with these types of maps. 
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Uncheck the Henderon Topo Layer (make it not visible) 
 
Your Map Data View should appear as below: 

 
 
 
This is a Digital Ortho Quad Photo of the NW Henderson Quad.  Later in class we will discuss 
how these photos are made.   
 
Go back to full extent.  Uncheck the Faults Theme (make it not visible). 
 
Now practice deleting Layer.  Deleting a Layer does not remove the data from the computer; it 
only removes the information from the current Map. 
 
Right Click on the Faults Layer and select Remove Layer.  
 
Also remove the Henderson Quadrangle Theme for the current Map. 
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Check the Lake Mead Layer (make it visible).  Then double left click on the Vegetation colored 
box. 
 
Your Map Data View should appear as below: 

 
 
 
 

 
 
 

Change the Symbol to 
Hollow, then change 
the Outline Color to 
Yellow, black will not 
be visible over the 
Aerial Photo. 
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Your View should appear as below: 

 
 
Notice the how the water goes thru the wash.  It doesn’t fill the whole wash.  Notice also the 
darker tones are vegetation in and along the wash. 
 
 

 
 
 
 

Right click on 
the Lake Mead 
Layer and select 
Properties 
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Click OK to complete the Layer Properties.  You labels are now ready but not visible. 
 
 

From the Layer 
Properties dialog box, 
use the Labels tab.  
Select as a Label Field 
Description (use the 
down arrow if you don’t 
see it) 

Black labels (the  
default)  will not 
show up over the 
picture so select 
Symbol.  

From the Symbol 
Selector pick the color 
Yellow and change the 
size to 10. 
 
Click OK 



GEY 430/630 – GIS – Theory and Application 

 
 30

Right click on the Lake Mead Layer in the Table of Contents (remember the left box of Layers) 
 

 
 
 
Your View should appear as below: 

 
 
 
You should notice that the area is defined as open water.  
 
 
 
 

Labels are made 
visible by clicking on 
this menu item  “Label 
Features”
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First change your paper from Portrait (up and down) to Landscape (side ways).  This Map fits 
better with this setting. 
 

 
 
 
 
 
Now use the handles of the image to fill the left 2/3 of the paper.  The right will be for the Title 
and Legend. 

Now you are ready to 
Print.  Select the 
Layout View 

Change to 
Landscape 
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Add Title, Scale bar, legend, north arrow and turn in the map for Part II. 
 
 
When you add your title lets make a multi-line Title.  Insert a Title as before but just add the first 
word, in this case “Henderson” and press enter.  Then double left click on the word 
“Henderson”, this brings up the Title properties.  
 

   
 

You can also get to the Title 
Properties by right clicking on the 
Title and selecting Properties.  
The double left click is just a 
quick short cut. 
 
Change Symbol is where you 
change sizes of type and colors 

When you add the Legend 
use the defaults but remove 
the Hen_DOQ_nw.Tif 
from the Legend Items 



GEY 430/630 – GIS – Theory and Application 

 
 33

To Turn In: 
Turn in two maps, the first with roads, faults, lake mead and the Henderson Quadrangle, the 
second with the digital ortho quad photo with the lake types and roads displayed.  Remember 
to include the following on these and all your future maps: 1) a title, including a description 
of the map and your name, 2) a north arrow, 3) scale bar, and 4) a legend.  Points will be 
deducted if you don’t have all these elements. 

 
Here is the Part II turn in: 
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Suggestions for Improvement: Practice with ArcGIS 
Please help me improve this lab.  As incentive, any improvements incorporated (or major errors 
removed) will gain you a point on your final grade total. 
 
 
What didn't work in this lab, and how would you fix it? 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
What was the best part of this lab exercise? 
 
 
 
 
 
 
 
 
 
 
 
 


